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Introduction 
The UC Learning Center is the web-based Learning Management System (LMS) used across the University of 

California for Systemwide training and development. Those who have direct reports identified in the UC 

Learning Center will receive the Manager Role, in addition to the standard Learner Role. In some cases, 

individuals may be given the Manager Role if they have been identified as needing access to manage the 

training of those who are not their direct reports. 
 

With the Manager Role, you can: 
 

• View training history and status of assigned training of direct reports or viewable users 

• View direct reports or viewable users current training schedule 

• Register direct reports or viewable users for activities 

• Assign activities to direct reports or viewable users 
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Logging into the UC Learning Center 
Log in at lms.ucdavis.edu using your UC Davis Login (Kerberos). 

 
 

Navigation 

Homepage 

When you first login to the UC Learning Center, you will see the homepage. Here you can launch activities you 

are currently registered in, navigate to your training schedule or transcript, and use search features to locate 

activities you wish to take. These will all be reflected on your own account. You can also get information about 

your direct reports. 
 

The Manager view is an enhanced version of the Learner view. For more information on Learner access, refer 

to the Learner Guide. 
 

 
 

• Manage My Registrations: View your Training Schedule, where you can see both upcoming in-person 

activities you have registered to attend, as well as any online activities you are currently in progress 

with. 

• Required Training: View a list of your required and recommended training where you can see details 

about last completed, Expiration, and your assignment status. 

• My Learner Dashboard: Access your required training and recently launched training 

• Transcript & Certificates: View transcripts for any courses you have completed in the UC Learning 

Center. 

• Find a Course: Search for a course. 

http://lms.ucdavis.edu/
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• How To: Short YouTube instructional videos 

• Support: 

• UC Davis Campus: 

▪ Contact UC Davis Staff Development and Professional Services at sdps@ucdavis.edu 

for assistance with the UC Learning Center. 

• UC Davis Health: 

▪ Please open an incident ticket through ServiceNow or call (916) 734-HELP (4357) for 

assistance with UC Learning Center. 

 

 

Top Menu 

The Top Menu will appear on every page.  Hover over each icon to see where they will take you.  You might not see every 

icon, depending on your permissions.  

 
 

 

 

 

 

 

 

 

 

 

Using the Manager Tools 
Once you have been identified as the manager of a user in the UC Learning Center, 

you will automatically have the My Team icon appear in the Top Menu. This will give 

you access to a Manager Dashboard. 

 

  

 
 

 
  

Home: Click to return 
to the homepage 

Self: View your Profile, Learner Dashboard, 

Training Schedule and Advanced Reporting 

My Team: Access Your manager 

Dashboard 

Library:  View courses 

organized by category 

 

Timeline: View assigned 

and required courses 

Search: Search the LMS 

https://www.youtube.com/playlist?list=PLHIqEsWz0OXZc4CXri_Eai66y3XrS-jIs
mailto:sdps@ucdavis.edu
https://ucdh.service-now.com/itss?id=new_incident
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Manager Dashboard 

When you navigate to your Manager Dashboard, you will be able to see: 
 

• A snapshot of your current exception report, which shows the overall status of your managed users’ 

assigned training. 

• A list of your managed users with the status of their individual assigned training. 
 

 

Note: Manager Dashboard is updated nightly, so if one of your users completed training after the latest update, 

it will not appear in this view until the next update. However, the user’s training transcript and schedule are 

displayed in real time and will show you their latest status. 

 
 

View Managed Users 
In the Manager Role, you have the ability to view information about your managed users and the progress of 

their assigned activities. 

Your viewable users will all be displayed in tiles on your Manager Dashboard. You can scroll through these 

tiles to locate a particular individual or you can search the user by name, or sort in ascending or descending 

order (by name, assignment progress, etc). 
 

You will automatically see all users you have been given access to view, either as your direct reports or as 

managed users whose training you are responsible for managing. If you manage more users than just direct 

reports, you can change your view from All Viewable Users to Direct Reports if you wish to only view your 

direct reports. 
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View Status of Assigned Training 
When you first enter your Manager Dashboard you will see an overview of your managed users and the 

status of their assigned training. The Exception Report at the top will show you the percentage of compliance 

your managed users are currently at for all training assigned to your managed users. For each individual, you 

will see the overall status of their currently assigned training. Click the blue INCOMPLETE button to see a 

more detailed report. Remember, you can also sort this list by process. 

 

 

Assigned Training by Activity 

You can also see which trainings are assigned to your managed users and the overall completion of the 

training. 

Switch from the Users view Activities view to see all the activities that are currently assigned to your 

managed users. You will now see how many are still required to complete each training and the overall 

percentage of completion. 
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Click on the blue Users button to see who is still required to complete the training. 
 

  
 
 

Individual Reports 

To view a detailed report for an individual user: 
 

1. Locate the user you wish to find out more information about.  

2. Click on the blue Incomplete button.  
 

This will show you an overview of the user’s assigned training, including a list of all training that has been 

assigned, the due date for each training, and their overall progress in completing all assigned training. 
 

 

 

1. Clicking the Title of the course will show you more information about the training. 

2. Using the menu bar on the left side, you can filter the training to show only what assignments are 

Overdue or what has been Completed. 

3. You will see when the information was Last Processed in the top right corner. 

4. Clicking the Close button will take you back to the Manager 

Dashboard. 

 

 

 

1 

2 

3 

4 
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Training Analysis 

Another way to view a user’s assigned training is to go to that user’s 

 

Training Analysis page. 

1. Locate the user you wish to find out more information about in your 

list of direct reports or viewable users. 

2. Click the drop-down arrow next to the white PROFILE button. 

3. Click Training Analysis. 

4.  This will launch Emulation mode , which allows you to view Learning details about your 

managed users. You know you are in emulation mode by the orange “eye” in the top menu bar where 

the “Self” icon would typically display. (To exit Emulation mode, click the “eye” and then click Exit 

Emulation) 

5.  The page provides an overview of the user’s currently assigned training, the due date for each training, 

and current assignment status. Click the View drop down menu to see additional information. 

 

 

 

 

 

 

 

 

 

 

 

 
 

View Training Schedule 
You can view a managed user’s training schedule to see their current registrations and progress. 

 

1. Locate the individual you wish to view. 

2. Click the drop-down arrow next to the white PROFILE button and select Training Schedule. 
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3. This will launch the Emulation Mode, which allows you to view Learning details about your managed 

users. You know you are in emulation mode by the orange “eye” in the top menu bar where the 
“Self” icon would typically display. 

4. Now you can see that user’s registrations and other canceled, in progress or completed training. 
 

 
 

Training Transcript 

To view all completed training for a managed user, you can view their 

training transcript. 

1. Locate the user you wish to find out more information about using 

the User Search function. 

2. Click the drop-down arrow next to the white PROFILE button  

3. Click Training Transcript. 

4. This will launch Emulation mode, which allows you to view 

Learning details about your managed users. You know you are in emulation mode  by the orange 

“eye” in the top menu bar where the “Self” icon would typically display. 

5. You will be taken directly to that user’s transcript. Select the timeframe you wish to review using the 

year or date range filters. Note the default view is for one year. 

You can view the transcript or individual certificates of completion and export them to PDF.  

To export the training transcript to PDF: 

1. Click Export to PDF in the top right corner.  

2. Click the link to download the PDF  

3. The PDF will open in a new window. 

To export individual certificates to PDF: 

1. Click the certificate logo next to the course name. 

2. Click Export to PDF and follow the steps above. 
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Register Users 
A manager can register their managed users for courses. It is recommended to register users for in-person 

training and assign online training. To register managed users: 

1. Locate the activity you wish to register by using either the Catalog or Search function. 

2. Click the Ellipsis (More Options) to the right of the course title and select Register Others. 

 

 

3. If this is an online course, click Continue to add users. If this is an in-person training, you will need 

to select the offering you wish them to attend first before you can click Continue. 

 

 
 
 

4. Click Add under Available Users to locate the users you wish to register. 
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5. There are several options to narrow down the users you wish to add. As Manager, the only option that 

will be relevant is Select Viewable Users. 

 

6. Click Next. You now have the option to: 

• Type a user’s name in the search box and click the Arrow button. 

• Browse the list of users for individuals you wish to register. 

• Click Select All at the bottom of the page to select all active users or select the top box to select 

all users on the current page. 
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7. Select the check box next to the user(s) name you wish to register. Click OK at the bottom to 

continue. 

 

8. Click the Top Arrow Button to move the selected users over to Registration. 
 

 

9. Click Submit once you have selected the users to be moved over. 

10. The users are now registered for the activity. 
 

Note: If the activity is in-person they will receive an email notification of their registration. If the activity is online 

there is no registration notification, so you may want to inform them they need to complete the training.
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Manage Assignments 
A manager can assign their managed users for courses. Manager assignments are recommended for 

individual assignments only. To assign managed users: 

1. Locate the activity you wish to register by using the Catalog or Search functions. 

2. Click the Ellipsis (More Options) to the right of the course title and select Manage Assignments. 
 

 

3. To add a new assignment, click Add. 
 

 
 

4. Select the user(s) you wish to assign the activity to (Note: You may need to click All Viewable Users if 

you do not have Direct Reports) and click Next. 
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5. Set the Type (Required or Recommended) and choose a Start Date 
 

 
6. Scroll down to set the Due Date and click Apply to Selection, then click Done. 
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7. Under the Manage Assignments screen, you can Edit or Remove the assignment 
 

 

Note: Users should receive an assignment notification later that night. If you need to assign 

training to staff based on job code / department and want to include transfers/new hires in the 

future, please contact the appropriate training group of the activity to setup an Audience to 

make the assignment. 

 

Advanced Reporting - Campus 
In preparing reports, supervisors can confirm their employees’ training status in a few ways. The 

easiest is to run an “UCD Campus Assigned Training Status Report” through their Advanced 

Reporting dashboard in the UC Learning Center (http://lms.ucdavis.edu). There are several report 

templates in the UCD Campus Folder to choose from. 

 

1. Click the Self icon (upper left‐hand corner of screen), click Reporting, and then click Advanced 

Reporting. 

http://lms.ucdavis.edu/
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2. Your screen should now display the Advanced Reporting dashboard: 

 
 

 

3. Expand the folder list on the left‐hand side of your screen to reach the UCD Campus 
folder: 

UC_PROD > Custom > Reports > UC Locations > UCD > UCD Campus 
 

 
 
 

4. Click the name of the report you wish to run 
 

UCD Campus Assigned Training Status Report Shows all individuals’ assigned training 

status.  This guide uses ePerformance Compliance Training Status—Cyber and Sexual 

Harassment Prevention Report as an example. 
 

5. Once your report appears, you can export it or Sort/Filter within the LMS report by 
clicking on the column title 
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To Export: 

Click the export icon and choose the desired format (e.g. Excel). 
 

 
 
To Sort/Filter within the LMS Report: 

When you run the report, it will provide all data. Click on the Course Name or Course Code, or any other 

column title to bring up sort/filter options: 

 

 

 

 

Click the Filter icon to bring up filter options - This example uses the “Course” column as the filter subject 
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After you click the filter icon you can click “Show only rows where” you may either use “Equals” or “Contains” 

and use your appropriate title in place of UC Cyber Security (or, you may use a date, etc)  

 

If you wish to filter before you export to excel, you can hover over the export Icon, and then as XLSX 

 (Once you have exported to Excel, you can sort and filter by course name or date, or even last name to see all 

completions for your supervised employees)  

 

Return to Report List 
If you would like to run other reports, select View > Repository to return to the report list. 

 

 
Reports you can run include: 

 

• ePerformance Compliance Training Status—Cyber and Sexual Harassment Prevention 

Shows all individuals’ cyber security awareness and sexual harassment prevention 

status training status. (Best for identifying mandatory training compliance for 

Pay4Performance program.) 

• UC Cyber Security (Initial and Refresher) Training Status Report 

Shows individuals who are either overdue or coming due for cyber security awareness training. 

• UC Learning Center Course Attendance Report 

Use this report if you would like to view all training completed by your employees. (Can be 

filtered to only display trainings completed during a given time period.) 

• UC Sexual Harassment Prevention Training Status Report 

Shows individuals who are either overdue or coming due for sexual harassment/sexual 

violence prevention training. 

• UCD Campus Assigned Training Status Report 

Use this report to view the status of all training assigned to your employees. 
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Exit Advanced Reporting 
Click the “University of California Learning Center” logo in the top center of your page to return 

to your UC Learning Center homepage: 

 

 
 
 

Advanced Reporting - Health 
 

 

1. Click the Self icon (upper left‐hand corner of screen), click Reporting, and then click Advanced 

Reporting. 
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2. Your screen should now display the Advanced Reporting dashboard: 

 
 

 
 

 

 

For Health 
Expand the folder list on the left‐hand side of your screen to reach the UCDH folder: 

 
UC_PROD > Custom > Reports > UC Locations > UCD > UCD Health 
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Execute Report 
Click the report you wish to run 

 

Once report appears, you can export it or Sort/Filter within the LMS report (before exporting)  
 

To sort/filter within the LMS Report: 
Once you run the report, it will provide all data. Left click on the Course Name or Course Code, or any column 

title/heading to bring up sort/filter options: 

 

 

 

Options 
Narrow your results by applying a filter from the Options menu 
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To Export: 

Click the export icon and choose the desired format (e.g. Excel). 
 

  
 

(Once you have exported to Excel, you can sort and filter by course name or date, or even last name to see all 

completions for your supervised employees)  
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Return to report list 

If you would like to run other reports, select View > Repository to return to the report list. 
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Contacts 
 

UC Davis Campus: 
 

• Staff Development and Professional Services 

sdps@ucdavis.edu 

530-752-1766 

UC Davis Health: 
 

• Human Resources Training & Development 

HS-T-D@ucdavis.edu 

916-734-2676 

 
• Center for Professional Practice of Nursing 

hs-cppn@ucdavis.edu 

916-734-9790 

 
• Information Technology Education 

hs-itedu@ucdavis.edu 

 

• Help Desk 

916-734-HELP (4357) 

 
 

mailto:sdps@ucdavis.edu
mailto:HS-T-D@ucdavis.edu
mailto:hs-cppn@ucdavis.edu
mailto:hs-itedu@ucdavis.edu

